The Oregon Budget Information Tracking System (ORBITS) is a client server application that uses an ORACLE database. You will log into ORBITS via the internet through a front end software called Citrix. Citrix allows ORBITS to be accessed from any computer with internet access, 24 hours a day, and seven days a week.

GETTING STARTED IN ORBITS

Access to ORBITS is a two-step process:

- **CITRIX** – users must first “log in” through this front-end software product.
- **ORBITS** – once the login to CITRIX is complete, the ORBITS Logon Screen appears.

Type in the Citrix address: [https://anywhere.das.oregon.gov](https://anywhere.das.oregon.gov) and press <Enter>. You may also access this through the SABRS Website. [http://www.oregon.gov/das/Financial/pages/SABRS.aspx](http://www.oregon.gov/das/Financial/pages/SABRS.aspx) and click on the ORBITS Login page link.
Type in your **Username** (RACF-ID) and Citrix **Password**. These fields are case sensitive.

Click `<Log On>` or press **Enter**.

Citrix may ask you to install the “Citrix Workspace App” (formerly Citrix Receiver).

Choose the “APPS” tab at the top of the screen. Click on the **ORBITS** icon. This navigates you to the ORBITS Logon Screen.

If you have trouble with Citrix, send an email to orbits.help@oregon.gov

The ORBITS login screen appears. Login using the username and password that was provided. **Note:** ORBITS and Citrix passwords are not the same. You must maintain both passwords separately.
Changing your Citrix Password

How to change your Citrix password:

1. Login to Citrix.

2. Choose the Gear icon in the upper right hand corner→Choose “Account Settings”→Choose Change Password

*NOTE* that the Passwords for CITRIX Must:

• Be a minimum of 8 characters
• Have a combination of alpha and numeric characters • Meet 3 of the 4 Complexity Requirements below:
  o Uppercase characters (A through Z)
  o Lowercase characters (a through z)
  o Numerals (0 through 9)
  o Non-alphabetic characters (such as:!, $, #, %)

Passwords should not contain personal information, be repeating characters or use sequential characters. "xxxxxx", "12345678"
Every 90 days you will be prompted to change your password within 7 days of expiration. Every time your password expires, it will need to be renewed as unique as there is no recycling of passwords.

You have 3 opportunities to put in your password correctly and then you will be locked out (3 strikes and you are out).

**Change ORBITS Password**

Menu Path: File → Change Password

This window is used to change your ORBITS password. Users may change their password at any time, but are required to change their passwords at intervals set by the System Administrator.

**Changing your ORBITS password:**

1. In the **Old Password** field, enter the password you are currently logged in with.
2. In the **New Password** field, enter a new password.
   
   ORBITS Passwords must:
   
   - be 6-8 characters long *(Note: ORBITS will allow you to continue to type but will cut the password off at 8)*
   - have an alpha first character
   - contain at least 2 alpha characters and 1 numeric and or/special character (1, 2, #, @, $)
   - differ from your User ID (may not be a reverse or circular order of your User ID)
   - differ from previous password by at least 3 characters. *(Uppercase/lowercase does not qualify as character changes.)*
3. In the **Retype New Password** field, re-enter your new password.
4. Click <OK>.
Introduction to ORBITS

Command Buttons

Command Buttons appear at the bottom of each window. A single mouse click on a command button executes the associated command. If a command button has an underlined letter, you can also execute the command by selecting the ALT+ the underlined letter. For instance, in most windows ALT+U executes the Update command button.

<Update>
This button is used to save newly entered or modified data. The appearance of this command button is controlled in Window Security Control. On many screens, pressing <Enter> also updates records.

<Insert>
This button is used to insert a new row or add a new record to a window (table). For example: Click <Insert> on the Budget Request Detail screen to add a new row of data (account and appropriated fund) to the budget. The appearance of this command button is controlled in Window Security Control.

<Delete>
When this button is selected, the current (highlighted) row is deleted. For example: Click <Delete> to remove a specific line of data on the Budget Request Detail screen. Many windows provide you with a warning pop-up to make sure you wish to delete the highlighted record(s). If you accidentally delete a record, you may <Undo> to reverse the process until an update has occurred. The appearance of this command button is controlled in Window Security Control.

<Undo>
This button reverses any changes made since the last update occurred on the open window. (If multiple changes have been made and the <Update> function has not been used, all of the changes are lost – not just the last change.) After clicking <Undo>, the user is prompted with the following message: ‘All changes since last update will be lost. Do you wish to undo?’ Clicking <Yes> executes the undo, clicking <No> cancels the undo.

(EXIT>
The <Exit> button closes the window you are working in. (Selecting <Exit> from the File menu or from the Welcome Screen closes the application.) You may also use the <X> command buttons at the top right of the window.
Clicking `<Notepad>` navigates you to the Notepad window. (Refer to Notepad window for further information.)

**Formatting Data Entry**

Each ORBITS window has been specifically formatted to meet the needs of the data for that window. The formatting affects both the appearance of a window along with the calculations that are applied to data entered on that window.

- Budget amounts are entered as whole numbers
- FTE amounts are the only amounts entered with decimal places
- Negative amounts are entered with a minus sign first and then the number
- Do not enter commas, dollar ($) signs or other symbols.

**Vertical and Horizontal Scroll Bars**

When there is more data than space available on a window, the vertical and/or horizontal scroll bars appear. Clicking on the up and down arrows at the right side of a window, or left and right arrows at the bottom of a window, enables the user to scroll through and see all of the data in the window.

**Drop-down Boxes**

An arrow appearing in a particular field indicates a drop-down. A drop-down box provides the user available options to select for that field.

**Split panes**

Splitting panes allows you to select data that remains visible when scrolling in a window. For example, row labels remain visible when you scroll through columns to the right. This feature is available for any window when the horizontal scroll bar appears.

1. At the left end of the horizontal scroll bar, point to the split box.

2. When the pointer changes to a split pointer, drag the split box to the right to the position you want. This allows you to scroll through all the columns on the right-side of the split box while still being able to see the row label.
Drag the split box to the right until you have the data in the left pane that you want to remain.
This is the first window that is displayed upon entry into ORBITS. You can navigate from here using the Command buttons at the bottom of the window or by using the menu bar at the top of the window.
Version Control
Menu Path: Welcome Screen \(<Version>\) or File \(\rightarrow\) Version Control

This window allows the user to select the version they want to work with. You will typically work in the following versions.

- A = Agency Working; this is where you create your CSL and Agency Request Budgets.
- J = Agency GB Working; use this version to reconcile your Agency Request Budget back to the Governor's Budget actions.
- K = Agy Leg Adopted Working; this version is used to reconcile the Governor's Budget to the Legislatively Adopted Budget actions.

When logging into ORBITS, the application defaults to the last Version selected by the user. This version identifier (Version ID) appears at the top of the Welcome Screen and includes the biennium, version type, version sequence number and agency number. Example: 2021-A-01-10700.

This Version Control window only lists agencies and versions that you are authorized to access.

Selecting a Version:

1. Select the Biennium from the drop-down. (Will default to the Bien from the Version the user is currently attached to.)
2. Highlight the Agcy No or Name for the desired agency. (ORBITS only displays the agencies that have been assigned to the user.)
3. Double-click on the Ver, Seq and Title of the version you wish to select. (Or, you may highlight Ver, Seq and Title and click <Select>.) (ORBITS only displays the version types that the User is authorized to select.)
4. Click <OK>. 
Using the <Copy> functionality:
1. Select the Biennium from the drop-down.
   *(Will default to the Bien from the version the user is currently attached to.)*
2. Click on Agcy No or Name to highlight the desired agency.
   *(Only agencies assigned to the User in their Security Profile appear.)*
3. Highlight the Version, Sequence and Title to select it as the source.
4. Click <Copy>.
5. Complete the pop-up window.
   a. Select the Target Agency from the drop-down.
      *(This drop-down lists Agencies from the Agency window)*
   b. Select the Version from the Target Version Type drop-down.
      *(This will list either the S, T or U versions.)*
   c. Type in a Title in the Target Version Title field or let it default.
   d. Select the appropriate sequence number in the New Version field.
6. Click <OK>.

**Note:** The new version contains the same financial data as the version from which it was created but the data will be aggregated to a summary level.

Using <Delete> functionality:
Agencies can only delete the S, T and U Versions.

Select the Biennium from the drop-down.)
1. Highlight the Agcy No or Name of the desired agency.
2. Highlight the Ver, Seq and Title.
3. Click <Delete>.
   a. A Popup window (Delete Version) appears. This popup shows the version to be deleted with a final warning message.
4. Click <OK>.

**Caution:** This action is irreversible. When a version is deleted from the Budget table the corresponding records in the Package table are also deleted.
Data Entry
Menu Path: Welcome → <Data Entry> command button or Preparation → Data Entry

The Data Entry window is one of two windows used to input and analyze detail budget amounts. The Actuals and Base Budget columns are the only columns available for input on this window.

When inputting changes to existing records, you can use your keyboard arrow down button or press Enter to move to the cell directly below. Upon exiting a cell and moving to another row, the record is automatically updated.

When you reach the last record in the table, the system will prompt you to select another record, or choose Insert to input a new record.

To create a new record:
Note: A record is considered ‘new’ when it is unique by Cross Reference No, Account and Appropriated fund. If any of these items already exist the user will get an error message “Unique Constraint....”

1. Select a Cross Reference No from the drop-down.
   (This drop-down lists active cross references numbers for the agency).
2. Click <Insert>.
3. Select an Account from the drop-down.
4. Select an **Appropriated Fund** from the drop-down.
5. Type the **Dollar amount(s)** in the appropriate column(s).
6. Click **<Update>** to save your changes.

**To modify a record:**
1. Select a **Cross Reference No** from the drop-down.
2. Highlight the row you wish to modify.
3. Make any necessary modifications.
4. Click **<Update>** to save your changes.

**Navigating from this window:**
1. Click **<Pkg Data Entry>** to navigate to the Package Data Entry window.
2. Click **<Notepad>** to navigate to the Notepad window.
The Package Data Entry window is one of two windows used to input and analyze budget amounts in packages.

When inputting changes to existing records, you may either use your keyboard arrow down button or select enter to move to the cell directly below. Upon exiting a cell, the record is automatically updated.

When you reach the last record in the table and presses `<Enter>`, the system inserts a blank row. If no change is made you may exit. If a change is attempted, you will be prompted to save their changes prior to exiting.

This window is specifically designed to display either the Essential or Policy Package column.

NOTE: If a specific cross reference number has not been assigned any packages, the number will not appear in the cross reference drop-down field.

To create a new record:

1. Select a Cross Reference number from the drop-down.  
   *(This drop-down lists active cross references for the Agency where at least one package has been assigned.)*
2. Select a **Package** from the drop-down. If the package is designated as Locked on the Packages window, the package appears in the Package drop-down to allow the user to view any dollars that have been recorded against it but the <Insert> button is protected.

3. Click <Insert>.

4. Select an **Account** from the drop-down.

5. Select an **Appropriated Fund** from the drop-down.

6. Type the **Dollar Amount(s)** in the column.

7. Click <Update> to save your changes.

**Navigating from this window:**

1. Click <Data Entry> to navigate to the Data Entry window.

2. Click <Notepad> to navigate to the Notepad window.

---

**Notepad**

**Menu Path:**  Preparation → Notepad or  Data Entry/Package Data Entry → <Notepad>

Notepad is used to record text attached to a Version and Cross Reference.
Create a new Notepad entry:

1. Select the **Bien**.  
   *(This drop-down lists Biens that have Versions in Version Control.)*

2. Select an **Agency**.  
   *(This drop-down lists Agencies that have Versions for the Bien selected.)*

3. Select a **Version Type**.  
   *(This drop-down lists versions that exist for the Bien and Agency(s) selected.)*

4. Select a **Cross Reference**.  
   *(This drop-down lists Summary Cross References for the Bien and Agency(s) selected.)*

5. Select an **Author**.  
   *(This drop-down lists User IDs that have Notepad records for the Bien/Agency/Version Type/Cross Reference selected.)*

6. Click **<Insert>**.

7. Select a **Version**.  
   *(This drop-down lists the Versions available for the Bien/Agency/Version Type/Cross Reference listed above.)*

8. Select a **Cross Reference**.  
   *(This drop-down lists Summary Cross References for the previously selected Version.)*

9. The **Date** field is automatically populated on **<Insert>**.

10. The **Comment** field displays the beginning of the entry in the **Comment Display** field.

11. The **Author** field is automatically populated on **<Insert>** with your User ID. This may be assigned using the Reassign User ID window.

12. Mark the **Display** indicator if this entry should be available to all users who have security for that agency. (See the table below.)

13. Mark the **Print** indicator if this entry should appear in the Notepad Entries report. (See the table below.)

14. Click in the **Comment Display** box to type your Notepad entry.

15. Click **<Update>**.

The table below shows the combinations of the Display and Print indicators and their corresponding results.

<table>
<thead>
<tr>
<th>Display indicator</th>
<th>Print Indicator</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td></td>
<td>Displays for all Users (w/ security for that agency)</td>
</tr>
<tr>
<td>X</td>
<td>X</td>
<td>Displays/Prints for all Users (w/ security for that agency)</td>
</tr>
<tr>
<td>X</td>
<td></td>
<td>Displays/Prints for owner only</td>
</tr>
</tbody>
</table>
**Column Labels – Select Column User Tab**

**Menu Path:** Administration → Admin Tables → System Titles & Column Controls → Column Labels → Select Column User Tab

The **Select Column User** tab is where users can customize which columns are visible for a specific Version in the Data Entry window. Any settings here on this tab override the standard column display.

This is useful when you are entering data into a single column, you can customize your view to display only that column. To return to the ‘Select Column Standard’ view, uncheck all columns.

**Personalize Standard Column for Users by Version:**

1. Select the **Bien** to setup from the drop-down.

2. Select the **Ver Type** from the drop-down.  
   *(This drop-down lists Version types created on the Version Types window.)*

3. The **User ID** defaults to the User ID that you are logged in as and cannot be modified.

4. Mark the **Column Checkbox** indicator next to the column numbers/names that you want displayed on the Data Entry window.

5. Click `<Update>` to save your changes.
ORBITS has several reports available to the user for various purposes. Below is a listing of those that are commonly during the budget development phase.

For more detail information on reports please refer to the Report Manual on the SABR Website.


ORBITS Overview for Agencies

Quick Reference

All Budget Development Phases

- AUD100 – Audit Error report. Used to determine if the budget data passes some predescribed edits that have been programmed into the application. These edits are driven by Version and Column.
- AUD004 – Transfers and Special Payments report. Run this report from your detail version to see if your transfers and special payments are in balance with other agencies. Transfers and special payments must be in balance between agencies or you will not pass your audit. These are run in the A, J or K Versions for the various phases.
**Actuals Phase**

- **AUD002A** – Agency Suspense Entries. Run this report to see if you have any entries in your Suspense Cross Reference Number (999-99-00-00000)
- **AUD003A** – Agency Actuals Audit Report. Displays the Legislatively Approved, the R*Stars Accounting Actuals and the Actuals column in ORBITS. Displays variances between R*Stars and ORBITS Actuals and between LAB and ORBITS Actuals.

**Current Service Level (CSL) Phase**

- **ANA102A** – Inflation Forecast Report – If you are manually entering your Inflation in Package 31, this report is useful as a tool to determine how much to enter. It’s important that Package 22 Phase Out entries are made before you run this report.
- **ANA103A** – Inflation Analysis Report. Displays the amount in inflation packages 31 and 32 as well as calculating the percentage of the inflation entered into ORBITS.
- **ANA104A** – Mass Transit Audit Report. Calculates the maximum amount of Mass Transit that is allowed by Fund Type. This report may be useful when determining the amount of Mass Transit to enter into Package 010.
- **BDV002A** – Detail Revenues & Expenditures – Requested Budget. The report shows components of the Agency Request Budget, including Base, Packages and Current Service Level. Essential and Policy Packages are displayed in total a separate columns. Agencies are able to see Revenue and Expenditure detail down to the appropriated fund type, as well as Positions and FTE by account.
- **BDV004B** – Detail Revenues & Expenditures by Package Group. This report displays packages as individual columns. Agencies are able to see Revenue and Expenditure detail down to the appropriated fund type, as well as Positions and FTE by account.

**Agency Request (ARB) Phase**

- **BDV102A** – ARB, Mod CSL, An Rec. Displays detail revenue and expenditure data at the detail account level. Used to review historical information along with current request. The first 5 columns on this report are hardcoded; the last is dynamic based on the Version that is selected. At this point column 5 and 6 will both display as Agency Request.
- **BDV004B** – Detail Revenues & Expenditures by Package Group. This report displays packages as individual columns. Agencies are able to see Revenue and Expenditure detail down to the appropriated fund type, as well as Positions and FTE by account.

**ORBITS Overview for Agencies**

- **BDV104** – Biennial Budget Summary. This report provides a different view of an Agency’s budget. It summarizes Expenditures for Base Budget, Essential Packages, CSL, Policy Packages and Agency Request Budget by Fund Type. This report does not show revenue sources.

**Governor’s Reconciliation**

- **ANA100A** – Used to compare versions and/or columns. During the Governor’s
Reconciliation this report is useful to determine the BASE column adjustments necessary. Compare the V01 Agency Request Version to the G01 Governor’s Budget Version at the Summary Cross Reference level.

- **ANA101A** – Used to compare Packages by Version. During the Governor’s Reconciliation this report is useful to determine what changes were made to Agency Essential and Policy Packages. Compare the V01 Agency Request Version to the G01 Governor’s Budget Version at the Summary Cross Reference level.

- **BDV200** – Analyst/Appeal Report. This report will be used during Governor’s Reconciliation Phases. Displays a summary of changes between the Agency Request and the Governor’s Budgets. Agencies will use this to reconcile back to the Governor’s Budget.

- **BDV004B** – Detail Revenues & Expenditures by Package Group. This report displays packages as individual columns. Agencies are able to see Revenue and Expenditure detail down to the appropriated fund type, as well as Positions and FTE by account. Use to verify that packages are balancing to what was approved during the Governor’s Budget.

**LAB Reconciliation**

- **BDV102A** – ARB, Mod CSL, An Rec. Displays detail revenue and expenditure data at the detail account level. Used to review historical information along with current request. The first 5 columns on this report are hardcoded; the last is dynamic based on the Version that is selected. This report will allow you to compare the Agency Requested budget to your final Leg Adopted Budget.

**Other Useful ORBITS Reports**

- **BSU002A** – Cross Reference Report. This lists Agency budget structures at the SCR and DCR levels, including structures that may be inactive.

- **STW007** – Statewide Query. This report is very flexible and can be catered to show data as needed, however, packages will be grouped into one column for essential and one column for policy.

- **STW009** – Statewide Package. This report is also very flexible and can be catered to drill down on package details.

- **STW011** – Statewide Comparison. This is a flexible report that may be catered to the user’s needs. It allows for a comparison of Versions and/or Columns.
ORBITS Overview for Agencies
### ORBITS Overview for Agencies

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Agencies enter data into this version at the detailed level (DCR) through ARB.</td>
</tr>
<tr>
<td>S</td>
<td>This version is created by the agency as a summary (roll-up) version of the A for audit purposes through ARB. They will run audit error reports from this version. This is called a Pre-audit version.</td>
</tr>
<tr>
<td>J</td>
<td>Agencies enter data into this version at the detailed level (DCR) for Governor’s Budget.</td>
</tr>
<tr>
<td>T</td>
<td>This version is created by the agency as a summary (roll-up) version of the J for audit purposes through Governor’s Budget. They will run audit error reports from this version as a Pre-audit version.</td>
</tr>
<tr>
<td>K</td>
<td>Agencies enter data into this version at the detailed level (DCR) for LAB.</td>
</tr>
<tr>
<td>U</td>
<td>This version is created by the agency as a summary (roll-up) version of the K for audit purposes through LAB. They will run audit error reports from this version as a Pre-audit version.</td>
</tr>
<tr>
<td>C</td>
<td>SABRS creates this version to audit the agency’s actuals.</td>
</tr>
<tr>
<td>E</td>
<td>SABRS creates this version to audit the agency’s CSL.</td>
</tr>
<tr>
<td>F</td>
<td>SABRS creates this version to audit the agency’s ARB.</td>
</tr>
<tr>
<td>H</td>
<td>SABRS creates this version to audit the agency’s GRB.</td>
</tr>
<tr>
<td>I</td>
<td>SABRS creates this version to audit the agency’s LAB.</td>
</tr>
<tr>
<td>V</td>
<td>This version is created post-audit for use in the ARB document.</td>
</tr>
<tr>
<td>Y</td>
<td>This version is created post-audit for use in the Governor’s Budget document (for agencies). This is the final product where the agencies balance their version to the G version. Agencies incorporate the data and changes from G version into their J version, which then creates this Y. There should be no difference between Y and G when all is said and done.</td>
</tr>
<tr>
<td>Z</td>
<td>This version is created post-audit for use in the LAB document. Please reference above (version Y). This version runs through the same process for LAB, reconciling to modified L.</td>
</tr>
<tr>
<td>B</td>
<td>This is the Analyst Rec. Working version used for analyst data entry.</td>
</tr>
<tr>
<td>X</td>
<td>SABRS creates this version to audit the analyst recommended budget entries.</td>
</tr>
<tr>
<td>W</td>
<td>This version is created to capture changes from appeals — entries made by CFO Analysts.</td>
</tr>
<tr>
<td>Q</td>
<td>SABRS creates this version to audit the entered appeal changes.</td>
</tr>
<tr>
<td>G</td>
<td>This version is called the Governor’s Printed Budget – it is the final product of what CFO Analysts are working towards.</td>
</tr>
<tr>
<td>L</td>
<td>This version represents data entered by the LFO analyst as their working version.</td>
</tr>
<tr>
<td>O</td>
<td>This is the audit version created from the L version (not often used).</td>
</tr>
<tr>
<td>P</td>
<td>This version represents the final LFO Leg Adopted (not often used).</td>
</tr>
<tr>
<td>M</td>
<td>This version is used to enter budget execution changes at the detailed level from E-Boards, Session, Admin Actions, etc.</td>
</tr>
<tr>
<td>R</td>
<td>SABRS creates this version to audit the agency’s Execution actions (E-boards, Session, etc.).</td>
</tr>
<tr>
<td>N</td>
<td>This version captures execution items at the summary level for current LAB.</td>
</tr>
</tbody>
</table>
## ORBITS Versions and Reports – Quick Reference

### Overview ORBITS Columns

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>D01</td>
<td>Download</td>
<td>R*STARS Interface/Download</td>
<td>Current LEG. Approved (6+9)</td>
<td>PICS Freeze</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A01</td>
<td>Agency Version</td>
<td>Adjust Prior Bien Actuals</td>
<td>Current LEG. Approved</td>
<td>Current Bien LAB</td>
<td>Current Bien LAB</td>
<td>PICS Freeze</td>
<td>Base Budget</td>
<td>Essential Packages</td>
<td>CSL</td>
<td>Agency Request</td>
<td>Agency Request</td>
<td>Agency Request</td>
<td></td>
</tr>
<tr>
<td>C01</td>
<td>Actualls Audit</td>
<td>Prior Bien Actuals</td>
<td>Current LEG. Approved</td>
<td>Current Bien E-Boards</td>
<td>Current Bien LAB</td>
<td>Current Bien LAB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E01</td>
<td>CSL</td>
<td>Prior Bien Actuals</td>
<td>Current LEG. Approved</td>
<td>Current Bien E-Boards</td>
<td>Current Bien LAB</td>
<td>Current Bien LAB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F01</td>
<td>ARB Audit</td>
<td>Prior Bien Actuals</td>
<td>Current LEG. Approved</td>
<td>Current Bien LAB</td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>CSL</td>
<td>Agency Request</td>
<td>Agency Request</td>
<td>Agency Request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>V01</td>
<td>Agency Request Final</td>
<td>Prior Bien Actuals</td>
<td>Current LEG. Approved</td>
<td>Current Bien LAB</td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>CSL</td>
<td>Agency Request</td>
<td>Agency Request</td>
<td>Agency Request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X01</td>
<td>Analyst Rec. Audit</td>
<td>Prior Bien Actuals</td>
<td>Current LEG. Approved</td>
<td>Current Bien LAB</td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>CSL</td>
<td>BAM Analyst Rec.</td>
<td>BAM Analyst Rec.</td>
<td>BAM Analyst Rec.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q01</td>
<td>Appeal/Adjust Audit</td>
<td>Prior Bien Actuals</td>
<td>Current LEG. Approved</td>
<td>Current Bien LAB</td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>CSL</td>
<td>Gov. Budget</td>
<td>Gov. Budget</td>
<td>Gov. Budget</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**ORBITS Versions and Reports – Quick Reference**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>K01</td>
<td>Agency Recon.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>CSL</td>
<td>Policy Packages</td>
<td>Leg Adopted Budget</td>
<td>Leg Adopted Budget</td>
</tr>
<tr>
<td>I01</td>
<td>Recon. Audit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>EBL</td>
<td>Policy Packages</td>
<td>Leg Adopted Budget</td>
<td>Leg Adopted Budget</td>
</tr>
<tr>
<td>Z01</td>
<td>Leg Adopted</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>EBL</td>
<td>Policy Packages</td>
<td>Leg Adopted Budget</td>
<td>Leg Adopted Budget</td>
</tr>
<tr>
<td>M01</td>
<td>Ebd/Sess/Adm Actions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>EBL</td>
<td>Execution Packages</td>
<td>Leg Approved Budget</td>
<td>Leg Approved Budget</td>
</tr>
<tr>
<td>R01</td>
<td>Execution Audit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>EBL</td>
<td>Execution Packages</td>
<td>Leg Approved Budget</td>
<td>Leg Approved Budget</td>
</tr>
<tr>
<td>N01</td>
<td>Final Leg Approved</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Base Budget</td>
<td>Sum of Base Adjust.</td>
<td>Essential Packages</td>
<td>EBL</td>
<td>Execution Packages</td>
<td>Leg Approved Budget</td>
<td>Leg Approved Budget</td>
</tr>
</tbody>
</table>